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Word and Excel tips

Sharon Parq Associates Inc. is offering user
groups a monthly series of Word and Excel
tips, the first of which appear this issue.
Thousands of Microsoft Excel tips can be
found at http://excel.tips.net. The Word tips
are at http://word.tips.net. — Page 17

They're here (Rick Smith’s
Halloween story).

— Page 13
New version of Ubuntu
released.

— Page 15
Acronis releases True

Image Home 2010.
— Page 18

COMMAND.COM

By Rick Curry, President

e all know about the big events coming up shortly. Be sure

to drive safely when you are out visiting family and friends

and cook your turkeys thoroughly. I added a note on our

calendar about the yearly Dia de los Meurtos celebration at

the Ventura museum. Sometimes I know that I will not have a chance to

tell you at the meeting about an event, so the calendar is my best bet for

letting you know what is happening in and around our city. I’ll mention a

couple of December events early: the Parade of Lights in Oxnard is going

to be celebrated on Dec. 12, and the Ventura Harbor Parade of Lights will
be Dec. 18 and 19.

We had a very full meeting in October. It ran a little bit into overtime, it

was very interesting, and we all learned a lot about Windows 7. It turns out

there is a good reason that talk went as well as it did. Toby
and Michael worked into the wee hours on Saturday morning
making certain that they were hitting all of the most impor-
tant highlights that could possibly fit into one meeting. We
are all very fortunate to have them donating their time to our
club.

Next meeting we will have more on Windows 7 as Gene

Curry

Barlow shows us how we can keep our Windows XP while

trying out Windows 7 through dual boot.
I have a smattering of technical topics I wanted to touch on this
month.

We do have machines to update club flash drives. Toby and Michael
have been so busy with preparing for Windows 7 that they have not been
able to simultaneously produce a shareware update for the drives. Bring
your drives to the next meeting and we will try to have some new software
for you.

If you have purchased one of the great new LCD video monitors, treat it
with care! They do not tolerate being poked at anything like the old glass
monitors, and keep ammonia based cleaners away from them. Tepid water,
a little mild soap, and a soft cloth are the ticket for cleaning them. Elbow
(Continued on page 3)
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Minutes of October Board of Directors meeting

The CIPCUG Board of Directors
held its monthly meeting on Oct. 24,
2009, following the regular meeting at
the Boys & Girls Club of Camarillo.

In attendance were President Rick
Curry; Vice-President Craig Ladd;
Treasurer Art Lewis; TOE Editor John
Weigle; Toby Scott, tech
adviser; Web Page and
ISP  Co-coordinator
Helen Long; and Secre-
tary Diane Mortensen.

The meeting opened
with a discussion regard-
ing the revenue of raffle
tickets versus what is
spent on door prizes. Art
Lewis, treasurer, stated that the differ-
ence between the revenue from raffle
tickets and the cost of door prizes usu-
ally comes out even. Last month, there

Mortensen

was a difference of $21 less received
than spent. This could have been that
there were only 61 members in atten-
dance at September’s meeting. Art in-
formed the board that the required raffle
registration had been renewed for an-
other year.

Craig Ladd inquired if the budget for
door prizes could be increased. There
are times when it is difficult to buy door
prizes that inspire an increase in ticket
sales. In addition, he asked if a larger
door prize such as a printer, a popular
software program, computer gadgets,
etc. could be offered.

It appears that the number of tickets
sold is based on the door prizes offered.
There was quite an interest in today’s
meeting door prize of one-half hour of
technical support offered by Ventura
County Computers.

More on Command.com

(Continued from page 1)

grease is definitely a bad idea. One of
the best bets is to do your eating in a
different room.

There were some questions about
video editing, and since I have a bully
pulpit, I’ll throw in my two cents worth.
I like to use a really simple program to
get the video from my camera onto my
computer. Sonic.com has a product
called MyDVD that does very little with
your camera beyond burn the video to a
DVD. I don’t use their package to make
DVDs, but I like to use their transfer
software to get the movies from the
camera to the computer because it is not
capable of doing anything beyond the
transfer.

Some software packages want to
reformat your video as it is imported,
and every time you reformat your video
you lose quality. Other packages want to
put markers in your camera, then only
pull in the part of the video they are
working with at the moment; this wears
out your camera. Give me the simple
downloader.

Most of the video packages you will

encounter do their best work in produc-
ing video clips. This is a single piece of
an event that you have recorded: the
presentation of the birthday cake and
blowing out the candles; the wedding
ceremony; one of the school perform-
ances. | am not recommending any par-
ticular package for this; there are a lot of
good ones. But these clips will usually
not fill a DVD, so you will want to put
several of them together, and use some
sort of packaging software to produce
menus that let you play these individual
clips. This is called “authoring,” and I
like to use DVD-lab Pro from media-
chance.com for this step.

And there will be times that you get
home movies on a DVD from someone
else and would like to take clips from it
and repackage them along with your
clips into a new DVD. I like to use
VideoReDo (VideoReDo.com) to grab
the clips from an existing (unencrypted!)
DVD, because VideoReDo does not
reformat the video in the process. That
means it works quickly, and you have no
loss in quality because of an unneces-
sary reformat.

Toby Scott stated that his company,
upon consulting with Rick Smith, could
offer a similar prize for future raffles. If
so and it was advertised ahead of time in
TOE, it could increase the sales of raffle
tickets.

Toby Scott made the suggestion of
putting the popular freeware programs
on an 8GB flash drive to be offered at
the December meeting for personal use
and Christmas gifts. Last year’s Decem-
ber meeting flash drive sales generated
excellent revenue for the club. Toby will
research the costs of 8GB flash drives
and if too high, the cost of 4GB flash
drives and report his findings at the No-
vember board meeting.

Art Lewis presented the treasurer’s
report, which appears elsewhere in this
newsletter. The report was approved as

(Continued on page 4)

When 1 talked last month about
video cards I forgot to mention some-
thing. I did talk about the number of
pipelines (the equivalent of multiple
processors). There used to be a trick you
could do with some of the cards. To save
cost, manufacturers would use the same
chips on all of their cards, then use soft-
ware to turn off some or most of the
pipelines on a card. That way they could
sell a number of products to different
customers with different priorities. For
the technically savvy, there were tricks
we could do to turn those pipelines back
on.

I found during my misadventures
that this trick is not very likely to work
any longer. The manufacturers have
gotten more adept at disabling features
in a permanent way when they manufac-
ture a card that they want to sell for less
without undercutting their more expen-
sive cards. If you have read instructions
online describing ways to dramatically
improve the performance of an inexpen-
sive card, don’t count on that trick work-
ing any longer.

Until next month, Happy computing!
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Migrating from XP to Windows 7 is November topic

Programs

Gene Barlow will conduct a webinar
on migrating from Windows XP to Win-
dows 7 at the Nov. 21 meeting at the
Camarillo Boys & Girls Club, 1500
Temple Ave. (southeast corner of Pon-
derosa Drive and Temple Avenue),
Camarillo (see map on page 20).

The doors open at 8:30 a.m., and the
E-mail and Internet SIG and the Com-
puting 101 SIG start at 8:45 a:m. If you
can show up early to help set up, please
do. The room seems to be different
every month, and we have to move lots
of tables and chairs around.

Barlow provided the following infor-
mation on the presentation:

“Windows 7 has generated a lot of
interest the past few months. While
many users stayed with Windows XP
and avoided going to Windows Vista,
these same users are now excited to
move to Windows 7. Windows 7 has
cleaned up many of the problems users
had with Windows Vista and has added
some new and exciting features not
found in Windows XP. This presentation
is not a description of these new features
or even a demonstration of Windows 7,
but will focus on how you can get from
your Windows XP or Vista system to
the new Windows 7 operating system on
your computer. Microsoft has led you to
believe that moving to Windows 7 from
XP will be almost impossible to do.

“That is simply not the case. There
are many great ways to move to Win-
dows 7 from Windows XP.

“One of the first things users of Win-
dows should do on their computers is to

Door prizes

We have two types of raffle tickets:
one for prizes offered by the presenter
and one for club-provided prizes. The
tickets for the presenter’s prizes are free
and limited to one per member.

The tickets for the club-provided
prizes are $1 each, $5 for six tickets,
$10 for 13 tickets, $15 for 20 tickets and
$20 for 27 tickets and are available to
anyone. Those who can’t stay until the
drawing may sign their tickets and give
the person selling the tickets a list of the
prizes they would like in the order they'd
pick them. Winners’ prizes will be held
until the next meeting.

Consignment table

A consignment table is set up at
every meeting. Anyone can buy, but only
members can sell.

The club gets 10 percent of the sales
price. Sold items must be picked up at
the end of the day’s meeting. Any items
not picked up will become the property
of CIPCUG and will be subject to dis-
posal at the club’s discretion.

CIPCUG is not responsible in any
way for items bought or sold at the table.
Each item is sold as-is unless otherwise
stated.

Meeting, SIG notices

If you would like e-mail notices of
regular meetings and SIGs, go to
www.cipcug.org, where you'll find a link
on the home page to sign up. The URL
is cipcug.org/listserv.cfm.

You will need your membership
number, which is on the back cover
of TOE, to complete the sign-up.

separate their data files from their pro-
gram files. This basic change to your
hard drive will better protect your im-
portant data files from viruses and Win-
dows crashes and also give you a better
way to back up your main hard drive. It
also makes moving to a new operating
system much easier to do. So, this is a
first step in getting to Windows 7. Nor-
mally, doing such a change to your com-
puter would require a major reinstall of
everything on your computer. But we
will tell you how to do it easily and will
even demonstrate this function for you
s0 you can see how easy it can be with
the right tools.

“Once you have separated your data
files from your program files, you can
turn your attention to installing Win-
dows 7 on your computer. There are

More on minutes ...

(Continued from page 3)
received.

An inquiry was made as to the lost/
missing computer equipment reported
by Michael Shalkey at September’s
meeting and Toby reported that it ap-
pears to have been stolen. Art asked

Rick if he had the equipment insurance
policy, possibly given to him by Past
President Paul Westefer. Rick will look
through the immense amount of infor-
mation passed to him by Paul and report
back at the next board meeting.

John Weigle announced that the

many ways to do this. We will look at
all of the options you have available and
recommend the best approach possible
for you to get to Windows 7 on your
computer. We will then cover the ap-
proach to installing Windows 7 on your
computer in some detail. We will even
demonstrate how to do this so that you
can see how easy it is to accomplish. To
protect you, our plan includes leaving
your stable older operating system on
your computer also. That lets you start
to use Windows 7 at your own pace and
not be forced into it immediately like the
Microsoft approach.

“This topic gets down to the heart
and soul of your computer’s hard drive.
It is one that all serious users of personal

(Continued on page 5)

deadline for TOE is no later than the
following Sunday, Nov. 1. This is be-
cause November’s meeting is on the
third Saturday instead of the usual fourth
Saturday of the month.

With no further matters to be dis-
cussed, the meeting adjourned.
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Facebook blocked: e-mails don’t arrive

Unless otherwise noted, questions at
the Internet and e-mail SIG and the
Question-and-Answer session are an-
swered by Toby Scott, our technical ad-
viser. Michael Shalkey, handles the com-
puter duties.

Internet and e-mail SIG
Reported by John Weigle

Facebook blocked

Q: A friend couldn’t open a Face-
book link in an e-mail. It was blocked by
a firewall.

A: Facebook is blocked by some
companies and schools and on some
home computers with parental controls
(as an example, it is blocked at our
venue, the Boys & Girls Club of Cama-
rillo). It’s something on the recipient’s

This month’s Q&A topics:
Internet and e-mail SIG
Facebook blocked
E-mail not arriving
Changing e-mail programs
Multiple copies of messages
Microsoft Essentials
Internet Explorer 8
Removing malware tools
Program not recognized mes-

sage
Norton scans

Regular Q&A

Miscellaneous Windows 7 ques-
tions

Install Windows 7 now or wait?

Upgrading XP

Transferring Verizon
book

Video editing programs

Backup issues

Calligraphy font

Governing domain names

Understanding connection

address

.Net problems speeds
Flash drives
computer or network. You can save and/ puter.

or copy and paste the link or picture and
send that with your e-mail. There’s no
way for you to determine why the link
won’t work on someone else’s com-

More on coming events ...

(Continued from page 4)
computers needs to understand.”

Other coming meetings:

Reminder: The November and
December meetings are on the third
Saturday of the month, not the fourth,
because of the holidays.

Dec. 19: TBA

SIGs

Except for the Thousand Oaks PC
Club Photo Group, the Special Interest
Groups (SIGs) are sponsored by CIP-
CUG and led by volunteer club mem-
bers.

Unless otherwise noted, the CIPCUG
SIGs run from 6:30 to 8:30 p.m. at
Ventura County Computers, 2175 Good-
year Ave., Unit 117, Ventura; phone
289-3960. From the 101 Freeway, exit at
Telephone, take Telephone south to
McGrath, turn left and go one block.
Turn right on Goodyear and right again
into the second driveway. Unit 117 is
the back, right corner of the industrial
building.

The pre-meeting SIGs are at 8:45
a.m. at the Boys & Girls Club in Cama-
rillo. The after-meeting SIG is at 2 p.m.
at The Star, 550 Camarillo Center Drive,
Camarillo.

There is no charge for members to
attend the CIPCUG SIGs.

The TOPCC Photo Group, which
meets at 6:30 p.m. at the Thousand Oaks
Library, 1401 E. Janss Road, charges $3
per meeting for those who are not mem-
bers of the Thousand Oaks PC Club.
The Web site is http://topcc.org/dnn/
SIGsPrograms/PhotoGroup/tabid/65/
Default.aspx.

The general schedule

First Monday (except in months that
have holidays on or near the first Mon-
day): TOPCC Photo Group.

Fourth Tuesday: Linux.

Fourth Saturday (or the regular meet-
ing day): Computing 101 SIG and Inter-
net and e-mail SIG, 8:45 a.m. Michael
Shalkey’s after-meeting SIG at The Star,
550 Camarillo Center Drive, Camarillo.

The schedules for the balance of

E-mail not arriving
Q: I have friends who get e-mail

(Continued on page 6)

November and all of December.:

November

Saturday, Nov. 21: 8:45 a.m. Com-
puting 101 and Internet, e-mail SIGS.
9:30 a.m.: Regular meeting, Gene Bar-
low webinar on dual booting with Ac-
ronis products. 1:30 p.m.: Michael
Shalkey’s after meeting SIG at The Star.
Topic: Zune, a great alternative to
iTunes — even without the Zune player.

Tuesday, Nov. 24: Linux SIG.
Topic New version of Ubuntu.
December

Monday, Dec. 7: TOPCC Photo
Group.

Saturday, Dec. 19: Computing 101
SIG and Internet and e-mail SIG, 8:45
a.m. Michael Shalkey’s after-meeting
SIG at The Star, 550 Camarillo Center
Drive, Camarillo.

Tuesday, Dec. 22: Linux. Topic:
TBA. Watch the Web site for possible
change in date because of the holidays.

Be sure to check the calendar on
cipcug.org for updates on event dates
and times.
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More on Q&A: e-mail issues; installing IE 8

(Continued from page 5)
from different people, but when they
reply, the replies don’t always arrive.

A: A lot of e-mail problems stem
from the rising amount of spam because
all Internet Service Providers try to
block obvious spam, but no two do ex-
actly the same things. ISPs might block
all mail from certain domains, such as
AOL and Gmail, while others look at
content. Four or five months ago, people
figured out how to get multiple Gmail
accounts and use them to send spam.
Lots of spam lists started listing Gmail
until they fixed the problem. The CIP-
CUG server subscribes to one of the
services and until I did a manual over-
ride, our server was blocking Gmail, too.

Smaller providers, such as CIPCUG
and Ventura County Computers might
be blocked because the larger companies
aren’t familiar with them or because
they don’t have the bells and whistles
that the other companies use to authenti-
cate. I periodically have to contact ISPs
that have blocked us to get unblocked. I
support several small companies that run
Exchange Server and I’'m always putting
out fires for them. To start to fix the
problems, we have to know the sending
server and the receiving servers.

This means that most people aren’t
going to be able to run mail servers at
home. I have Time Warner, for instance,
and it won’t let me run a home mail
server even if [ want to.

We put up the new Ventura County
Computers mail server 2 to 2 1/2 years
ago because we were getting 91,000 to
93,000 messages a day. The new server
with a new filter program cut the num-
ber to 9,000 to 12,000 a day. We’re up
to 18,000 to 19,000 a day now, and I
expect we’ll have greater problems.
Handling e-mail is a huge expense and a
huge bother, because no provider is go-
ing to give you the whole world of e-
mail.

Changing e-mail programs

Q: I'm still on AOL because of my
wife. I have Yahoo and Verizon e-mail
addresses. Should I move to Gmail?

A: AOL is for sale because it’s hem-
orrhaging money. If you’ve spent years
building up an address book and e-mails
on AOL, be prepared for it to go away.
If you’re using AOL, get another ac-
count and tell people to start using the
new address. Yahoo, Hotmail and Gmail
are not that different, but if you have no
other accounts, Gmail might be a good
place to start. AOL and some other free
e-mail providers make it difficult, if not
impossible, to export your address book
and mail, although some solutions have
been offered on the Web. Gmail, Hot-
mail and Yahoo mail all have easily
accessible and importable addresses and
mailboxes. Use them in preference to
most others.

(To a question) Earthlink has an e-
mail subscription service for $3 a month.
CIPCUG will let you have an e-mail
account for $15 a year, and it includes
Web access.

I’ve had the scotts.net domain since
1994 and use it for e-mail. I can keep the
same address and move the domain any-
where in the world if my ISP goes away
or the service becomes bad.

Comment from audience: I was in
Maine for a month and had no problem
checking my e-mail at CIPCUG.org.

Comment from audience: I have
Verizon and get very little spam. I can
check the spam on the Web.

Toby: I like Hotmail because I can
make spam and nonspam rules. Micro-
soft picks up spam definitions from Hot-
mail to use in Outlook updates.

Multiple copies of messages

Q: I get two copies of messages in
Thunderbird.

A: You might have filtering rules
that makes copies of messages to sepa-
rate folders.

Q: I do leave messages on the server
for a while.

A: I have lots of folders in Outlook
that I direct mail to with rules (family,
CIPCUG, etc.) My in box is primarily
suspected spam, and that’s where I look
last.

Q: Can Hotmail and other Web mails

do that?

A: If you’re looking at the mail on
the Web in those, no. You have to
download the mail to your computer to
sort with the rules. Gmail, Hotmail and
Yahoo Mail all allow you to download
your mail messages to an e-mail client
(Outlook, Microsoft Mail, Thunderbird,
etc.)

Microsoft Essentials

Q: What about Microsoft Essentials?

A: That’s the subject of Michael’s
SIG this afternoon.

Michael: 1 think MacAfee, Norton
and AVG could be out of business in
two years because of Microsoft’s free
anti-virus program.

Toby: I agree on Norton and
McAfee, but not AVG. Its primary busi-
ness is on servers for big businesses.

Internet Explorer 8

Q: Windows Update keeps pushing
me to install IE 8, even though I don’t
want it.

A: IE 8 is good, but it won’t run on
some computers. It’s fairly easy to
uninstall it and go back to IE 7. IE 8
uses more resources than IE 7, and some
installations fail. Some Web pages look
strange in it, but that’s the fault of the
designers, not the program. Early ver-
sions of IE were not good about Web
standards, and a lot of designers did
things that didn’t meet standards be-
cause IE had the biggest market share.
As other more standards-compliant
browsers were developed, most newer
pages met the standards. But many older
pages have not been updated, and be-
cause IE 8 is much better about being
standards-compliant than earlier ver-
sions, many of those pages look funny in
it. IE 7 was more complaint than the
earlier versions of IE, and IE 8 is about
where Firefox and Opera were two years
ago, meaning it’s 97 to 98 percent com-
pliant. Some pages display well only in
IE 5 and 6.

Q: When my computer says pro-
grams are ready to download, how do I

check to see if IE 8 is among them?
(Continued on page 7)
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More on Q&A: malware tools: Windows 7

(Continued from page 6)

A: If you don’t use IE, go ahead and
get IE 8 because you do need it for Win-
dows Update and it’s much more secure
than earlier versions. In Internet Ex-
plorer, go to Windows Update > Cus-
tom, which shows the list of updates.
You can also do manual updates.

Michael: Right click on the notifica-
tion icon and you can pick the updates
you want. If you don’t agree to the li-
cense for a specific update (i.e., IE 8), it
will stop asking you.

Toby: If you go to Windows Update
you can also remove items from the up-
date list.

Removing malware tools

Q: Microsoft Essentials says to re-
move other anti-virus and other anti-
malware programs. Does that include
Spybot?

A: It depends. You only want one
anti-virus or similar program running
real-time checks because they’ll conflict
with each other. If you have Spybot’s
TeaTimer application running, you’ll
have to turn it off or even better,
uninstall it. Other programs might also
have tools that run in the background, so
be careful. The professional version of
Malwarebytes runs in the background.

Q: Hasn’t Spybot learned yet that it
causes that problem?

A: In fairness, Spybot is one guy in
Germany and a couple of volunteers.
TeaTimer works with some programs on
some computers but not all. Some anti-
virus programs have no spyware detec-
tor so it’s not a problem on those sys-
tems.

‘Program not recognized’ message

Q: I have a problem with an old da-
tabase program that I use regularly and
keep getting warnings that the program
is not recognized. The program runs, but
the warning is a nuisance. Can I fix that?
I’m using Windows XP.

A: The message shouldn’t keep com-
ing up. What firewall do you use? (AVG
anti-virus and firewall).

Try turning the AVG firewall off and
using Windows Firewall. In the Win-

dows Firewall, you can allow a program
through the firewall.

Norton scans

Q: In the past month or so I’ve been
getting messages that say Norton is per-
forming a background scan. Is that a
danger? Should I be concerned?

A: That one is OK. When Norton
AntiVirus 2009-2010 detects that the
mouse and keyboard haven’t been used
in a certain time period, it will get up-
dates and start background scans that
used to slow the computer down while
you were working. It’s a good addition
to the program.

.Net problems

Q: I’'m getting messages that a .Net
update failed. What is .Net, and do I
need it?

A: Don’t install it unless you have to
— meaning if a program says it needs it,
install it. But otherwise, don’t. There are
several versions and some of the installs
and updates don’t work. You can try
uninstalling updates one at a time until
the problem is solved, but it usually eas-
ier to uninstall the whole thing. Pay at-
tention to versions. .Net 1 is a com-
pletely different program than .Net 2,
which is different from .Net 3. Only
uninstall the version giving you prob-
lems.

Net is Microsoft’s program to let
Web sites talk to each other. Their ad is
about someone who gets hurt in San
Francisco on a trip, deals with his insur-
ance company on the Web to find a doc-
tor on the program, checks the calendars
of several doctors until he finds one who
has an opening and makes an appoint-
ment on the doctor’s Web site. When
you do this you’re pushing stuff or hav-
ing stuff pushed to you, and some of it
might be something you don’t want. If
you allow Active X to run, you don’t
know what’s in it. Your only control is
how much you trust the company that’s
sending it. .Net is a security issue, but
many database programs need it to oper-
ate. It’s a program, not the Net domain
name.

Regular Q&A
Reported by Diane Mortensen

Miscellaneous Windows 7 questions

Toby’s introduction: These questions
I have been asked around six times in
the last month, and I would like to an-
swer now rather than make it part of our
Windows 7 presentation today. Some of
the questions: Should I wait and buy a
computer with Windows 7 installed?
Should I upgrade to Windows 7? Other
questions were variations of the same
topic, Windows 7 program install. My
question is if you are buying a new com-
puter and you do not buy a Windows 7
computer you are brain dead. Microsoft
has said that it will support only two
operating systems at a time. All of us
know that Vista was an unpopular sys-
tem, and Microsoft will be forced to
support XP for longer than yesterday,
when Windows 7 came out. If it is going
to support only two at a time, that would
be Vista and Windows 7, and XP is on
the cutting board.

A lot of people in this club keep
computers for more than two to three
years. Many will want a computer to
last five or six years and some 10 years.
We still get 98 machines coming into
the shop, and we just roll our eyes. If
you think that is something you might
want to do with the computer — even if
three years from now you will get an-
other primary computer and the old one
will be a hand-me-down to spouse,
friend, etc. — if you’re buying a new
computer with XP it will not be sup-
ported for the life of the computer and
you will end up with a dead box. There
will be no security protection and you
will not be able to go on the Internet
safely. I do not see the Internet getting
safer and safer over the next couple of
years, and you will short circuit your-
self. That is number one. Number two:
Windows 7 is a better operating system
than XP and it’s not just a little bit bet-
ter, but by an order of magnitude.

Several of the major computer writ-
ers who were Vista bashers have been

(Continued on page §8)
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Vista bashers all along, never liked Vista
and have been using XP still, yet when
the Windows 7 beta came out, they went
“Wow!” They have already made the
switch to running Win7 beta before the
product came out and using the beta as
their primary Windows platform. One of
the people who had been a Vista basher
came out and wrote in May 2009 the
beta of Windows 7 is the best operating
system Microsoft has ever produced.
That is the beta, not even the release
candidate, much less the final. The sys-
tem is hugely more stable than anything
I have ever seen from Microsoft. This
may sound paradoxical, but the reason it
is so good is that Windows 7 is Vista

Install Windows 7 now or wait?

Q. I am getting a copy of Windows 7
in the mail and it came with my new
computer. Do you recommend installing
it as soon as get the software or wait?

A. If you are going to install it, there
is no reason to wait. There is nothing in
your Vista for which Windows 7 isn’t a
massive improvement. There is nothing
new that will go bump in the night.
Vista was an entire rewrite on XP.
There was not one line of code in Vista
that was in XP, and that was the reason
they had all those problems. It has taken
them this long to sand off all of the
warts and get it all up and running.
Windows 7 is just a much cleaner ver-
sion of Vista — a very cleaned up ver-
sion. If you are going to do it, you may
as well as do it in a long weekend.

Upgrading XP

Q. I have an OEM version of XP.
Can I buy upgrades and then install
Windows 7?

A. Yes, you can do that. Let us agree
that we will not entertain any more Win-
dows 7 questions in this Q&A and wait
until the regular meeting to field those
questions.

Transferring Verizon address book

Q. How can I transfer a Verizon ad-
dress book to another e-mail account?

A. If you are using online Verizon,

the answer is I do not know. I would
look on your Verizon e-mail account for
the calendar/address book and see if you
can import that to another e-mail ac-
count. This was one of the problems
with AOL; it does not make it easy be-
cause it wants you to be forced to stick
with AOL. When you open an e-mail
account these are some of the things you
want to consider. That is why I prefer
using a real e-mail program, not Web
mail. T use Outlook all the time, and I
own the data and do not need to rely on
anyone else giving me back my own
data.

Video editing programs

Q. I just got a new toy, a video cam-
era, and I am entering the wonderful
world of video editing. I am currently
using Magic Pro 15 program, which is
supposed to be a good program; how-
ever I have found it completely unstable.
As far as [ am concerned, it is worthless.
My computer is 2.6 GH processor and 6
GB of RAM, and I am getting memory
allocation errors and it’s the only pro-
gram showing that error message. The
two questions I have are (1) What video
editing program do you use that you
found stable that I can go out and try,
and (2) How, generally speaking, how
big a clip can you expect to edit at one
time? Maybe I have too many and that is
the problem.

A. Since never in my life have I ever
edited a video clip, I do not know what
to tell you. Does anyone have any sug-
gestions?

From the audience: Premiere Ele-
ments, Pinnacle Studios, and Magic
Movie Editing.

A. Elements is an Adobe product.
and we all know that Adobe products
aren’t cheap, but they do tend to work
and they have support. On the Web un-
der “the top 10 video editing software
reviews,” No. 3 is Adobe Premiere Ele-
ments; No. 5, Pinnacle Studios; No. 4,
Magic Movie Editing. Make sure that
whatever program you select to use has
backup support.

Back to the original question and the

memory error message, my suspicion is
that it will probably be your install or
something went wrong with your com-
puter and not enough horsepower, mem-
ory, or too big of an item. What was
shown appears to be a fair review sys-
tem. Outside of Magic, I know all those
companies — Pinnacle, Adobe, Corel —
and they are all responsible companies.
If you have memory allocation errors, it
will not blow up the computer mid-
stream.

From the audience: I use Magic 14
and have no trouble with it, but I have
had to contact them by e-mail to Ger-
many. They come back and solve any
problems I might have. I am very happy
with the program.

A. The digital photo club in Thou-
sand Oaks also may be able to help you.
It is worth a try. Their programs are on
CIPCUG’s calendar.

Backup issues

Q. This is a question on backup. I
have a desktop and a laptop and every-
thing on my desktop in the way of let-
ters, photos I have on my laptop. When
Gene Barlow spoke the last time, I
bought a portable hard drive and I am
always afraid to do anything, but I did
install his program on my desktop. It
was my understanding it would copy the
whole computer program, the operating
system and data, so that if my computer
crashed I would have the backup to put
on. However, if I buy a new computer,
and obviously I’m not going to have the
XP program, do I go ahead and continue
with that or somehow use the program
on my hard drive and then copy it over?

A. In terms of backup, there are two
kinds of backups. One is a backup of the
whole computer, operating system and
everything else. Second, there is a
backup of just data. Most of us do not
have that much data. If you have videos,
music libraries, and huge archives of
photos, that might be different. How-
ever, for most of us in this room, we do
not have much data. I strongly recom-
mend that you make one copy of your

(Continued on page 9)
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image backup that is of the entire com-
puter. You would only need to do that
every month or couple of months. The
only time you really need to worry about
a backup is when you install a new pro-
gram that you suddenly start using a lot.
It is then that you would want to make
another image backup, but you would
not have to update that very often.

What you want to update daily is
your data so if the computer dies you do
not lose all your e-mails, added contacts
in the last several days, data from your
accounting programs, and the last batch
of family photos. That is the data you
want to back up and do it on a daily ba-
sis. Most of the USB drives you buy,
unless you have very huge qualities of
data, have plenty of space on there to do
both. The backup of your data will be
small.

Q. So are you saying that the pro-
gram that came with the hard drive to do
the data backup or what?

A. You can use any backup program
you want, but generally speaking if you
use a program to back up the entire com-
puter and that program will do the data
as well, then stay with that one program.

Going back to your original question
that you were looking at getting a new
computer and getting rid of the old in
the short term and you are absolutely
certain you know every location for your
data, then you can do a data backup. A
lot of us do not know where the data is
located. Quicken is famous for putting
the Quicken data files in your Program
Files, which nobody backs up; therefore,
the Quicken data does not get backed
up. If it were my computer and I were
planning to get rid of it, I would use the
drive image to make a complete image
of my computer. Then I would use the
drive image in the program mode to
copy all of the known data I have and I
am sure that I can get to it and I would
do both. That is the safest way to do it
and continue backing up often. I would
make sure that Intuit or Quicken does
not put the data in someplace strange
and it puts it in the My Documents

folder.

Q. So when I get a new computer
what goes from the True Image would
be just what I put onto the new com-
puter, not everything that is on it?

A. You would restore the data in the
data backup, not in the image backup.
You can also go into your image backup
of the entire computer and backup just
selected files. You do not have to copy
the image over because you would have
the data and you can pick off the indi-
vidual programs that you need. It is do-
able although you may need some help.

Calligraphy font

Q. My wife wants me to get her a
calligraphy font set. This is a two-part
question. One is where can I find this
kind of program just by Googling? Sec-
ond, how do you go about installing the
program or whatever and where do I put
it?

A. First you can Google the subject.
Sometimes when you search you’ll
come upon a site that appears to be what
you want, but when you go there, the
site is dead. What happens is that some-
body will have a site they got tired of
keeping up, maybe because they are not
making the business they initially
thought would happen. They decide not
to renew and some hijacker goes out and
grabs the same site. He puts all of the
stuff in the header to make it look like it
is a calligraphy site, but when you click
it on, it says, “You want to buy this
site?” He is just looking for someone to
buy the calligraphy site. You get this all
the time from hijackers who think they
can make thousands of dollars on these
sites. If you have a domain and you let it
expire, you can count on someone ask-
ing you for a thousand dollars to get it
back. They will register the site for
$9.95 from GoDaddy, but they will
charge you $1,000 to get it back.

Depending on what program you are
in, you can go out and download fonts,
save them and then open to install.
Some locations for fonts are
www.fontriver.com, www.dafont.com or
go to download.cnet.com and search for

Calligraphy fonts.

Governing domain names

Q. I understand that the United
States is giving up its domination of its
domain name and given to some type of
international control and have more peo-
ple involved in it. What is your opinion
on that?

A. It has been a gradual migration
going on for a long time. ICAAN (the
Internet Corporation for Assigned
Names and Numbers) handles the basic
stuff. Essentially, the Internet is going to
have more international control, and that
is just the way that it is, the natural order
of things. The basic motivation behind
the move is to allow domains to be reg-
istered in non-Roman characters — Chi-
nese, Cyrillic, Arabic, etc.

Understanding connection speeds

Q. I was in the Verizon store yester-
day, and they tried to interest me in a
Netbook and talking about the difference
with the connection speeds. I realized I
did not understand what 5 MPS or 15
MPS means. Does that mean what I can
do in an instant or the total amount I can
do in a month? Could you explain that? I
did not understand the language or what
it would mean to me when I was work-
ing on the Netbook.

A. It’s a measure of what you can do
in an instant. However, download speed
is only part of the story. When you are
doing Google searches, you want to go
out to get a page, it sends you out to all
these little pages, and you click on next,
then to next page. In that instance,
download speed does not make much of
a difference because the second aspect
of speed on the Internet is what they call
latency. This means when you send a
message out, how long does it take to
get returned back from the other person.
Or, if they send you a request for infor-
mation, how long does it take your com-
puter to get it back to them? DSL has
very fast sustainable download speed.
Latency is terrible so do not use it as a
server because it is slow. A 1.54 MPS
T1 on a Web site will run circles around

(Continued on page 10)
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a 25 MPS connection. If all you are do-
ing is surfing the Web and reading e-
mail, any DSL will work as well as the
fastest DSL connection because they
both have the same latency.

DSL latency speed does not change
when you increase download speed.
That is why about 10 years ago there
was a deal, where everybody was going
to get Internet over the satellite. It still
gets incredible download speed. The
problem is that the latency is like two
minutes. Therefore, every time you send
a query out, you can go and get a cup of
coffee. If the query was to send a large
amount of data, upon your return it will
have started and the data would come in
a rush. However, when you ask another
query, you can go get another cup of
coffee. It was so long that it became an
annoyance and the same thing when
they tired to go to satellite for a long-
distance telephone. There was a time
when MCI and others were using satel-
lites for long-distance calls. Everyone
screamed bloody murder because there
was this half a second delay listening to
someone talk. You would say something
and you did not get back the answer in
real time; that is latency. If all you are
doing is looking at Web pages and not
doing long sustained downloads, then
download speed is a waste of money.
That is unless you get psychic rewards
because you can go to cocktail parties
and brag that you have 25MB download
speed. It might be worth it for that, but it

does not do anything for you. Ninety
percent of the people in this room it does
so little that it would be a waste of time.

Flash drives

Q. I have a question about flash
drives. I have three — one is the CIP-
CUG flash drive, and two that I have for
data backup. When I go to plug in one
with data, the computer says flash drive
“T” and I can download on to it; the
other one does not come up. I go to My
Computer and it does not register.

A. Flash drives do die. Try it on an-
other computer to test if it does the
same. If you do not have another com-
puter, bring it to the next meeting, and
we will try it on one of the computers
here. Flash drives do die and that may be
all that it is. You can also kill them. If
you are wiring your computer and build-
ing it yourself and accidentally get the
USB plug on the front of the machine
plugged into the motherboard back-
wards, that can kill a flash drive. They
are also are not waterproof. A member
left his flash drive in his pants and his
wife washed them; there went his flash
drive.

Solid-state drives

Q. What do think about the life ex-
pectancy of these solid-state drives that
are coming out?

A. There are flash drives out there
that use the flash technology. They put
them in the size of a regular hard drive
and put them in the computer and you
can get up to about 400GB, which is a

decent size drive, but they cost around
$500. The problem is that the flash is not
a copy-forever medium and will eventu-
ally wear out. I do not know how long
and believe no one knows. We do have
tools that can do checks on disks and
lockouts, faulty sections, etc. Therefore,
you might be able to use some tools to
extend the life of the drive even if one
section goes bad. Unless you have a
compelling reason, I would not jump on
that technology yet because I believe it
is too soon. If I did get that technology I
would get a smaller drive and set it up as
the C: drive, set up my operating system
on it, which tends to be programs that do
not change very often, except for Micro-
soft updates. Then I would put all my
data on a different drive and put up with
a slower, more time-tested drive with
my data because data becomes the small
component and the operating system a
large component. You get a boost of
speed and you would not wear your
drive out as rapidly. That is what I
would do, but will it last three, four, five
years? I do not know.

Michael comment: I have a friend
who did exactly that. He has money to
throw around and he bought the flash
hard drive as the Windows drive and he
can get the drive to boot up in like 14
seconds. Depending on whom you ask,
one of the experts I was listening to said
the problem with flash drive is not the
age — like if I put the drive on a shelf,
how many years later can I still read it?

(Continued on page 11)
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The problem is that it can write only 10,000 times or
100,000 times, or a limited number of times. It can read,
no problem, but it can only write 100,000 times and it is
not a 100,000 writing to it, it is 100,000 times for each
sector of the drive. In my lifetime, I am more likely to
lose a flash drive, or plug into a bad computer and have it
fried, or stop using it because I bought one that was five
times the size for half the cost, than I am to have it die of
natural causes. This is where we get into trouble with
Windows because the temp file is always writing. When
you get your Windows drive in flash technology, no one
knows yet how long it will last.

Toby: There are solutions to the temp drive. You
could put your cache on another drive, either a cheap
flash drive or a hard drive and not worry about it. The
thing to recognize is that you have a limited number of
writes in the data, and it will not last forever. How long,
we do not know. A theoretical number in a laboratory
and real world experiences do not always dovetail. It is
not where I would put my data. I would put an operating
system on it and copy it, but not data.
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Shalkey and Scotit
infroduce Microsoft’s
new operating system

By John Weigle

Jweigle@vcnet.com
ichael Shalkey and Toby Scott introduced us to
Windows 7 in October, and they emphasized that
it was only an introduction even though the meet-
ing ran past noon because it was often inter-
rupted with questions.

Shalkey said he and Scott prepared their presentation after
reviewing Paul Thurrott’s Windows Super Site — also highly
recommended the next day by Leo Laporte on his radio show.
Thurrott is the co-author with Rafael Rivera of the book
“Windows 7 Secrets.” Thurrott is one of the many early users
who say Windows 7 is the best version of Windows ever,

(Continued on page 12)
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Shalkey said, noting that Thurrott also
liked Windows Me, which few others
did, because it introduced features we
take for granted now.

Vista users will see a lot of familiar
features in Windows 7, Shalkey and
Scott agreed, because it’s a revamped
Vista with most of the problems that
people complained about revised or
eliminated.

Microsoft let everyone download
Windows 7 to see how it worked,
Shalkey said, and those who registered
and activated a release candidate can
pay the upgrade price for the final ver-
sion. Apple never did that, he added.

Windows 7 comes in six versions:
Home Basic, Starter (designed for net-
books), Home Premium, Professional,
Enterprise and Ultimate. The first two
are for computers with little power.

Home Premium is the version most
likely to be placed on new computers
and Professional is the one most busi-
nesses will want. Most of us will never
see the Enterprise edition, and Microsoft
seems to be pulling back from Ultimate
and not promoting it, Shalkey said.

Most people will get Windows 7
when they buy a new computer, Shalkey
said, but users can upgrade machines.
Any computer that will run Vista will
run Windows 7, Shalkey said. Scott said
that businesses will want the Profes-
sional version because it can connect to
domains. Most medium and large busi-
nesses require their users to connect to a
domain, with layered permissions, etc.
Home users don’t need this level of se-
curity, hence the continuing distinction
between Home and Business versions.

Before installing Windows 7,
Shalkey reminded us, back up your data
— and your whole computer if you think
you might want to go back to your cur-
rent operating system — and be sure you
know how to restore from the backup.
Find your program CDs and registration
numbers so you can reinstall them.

It’s best to do a clean install of Win-
dows 7, but it’s possible to upgrade from
Vista, Shalkey said. Scott advised in-

stalling the 64-bit version of Windows 7
because the world is moving to 64-bit
from 32-bit, and new software won’t
come in 32-bit versions in the next few
years. The advantage of a 64-bit system
is that 32-bit software can use only 4
Gig of RAM and the 64-bit can access
any amount — well not really, but the
number is 17 digits and doesn’t have a
prefix (kilo, mega, giga, tera, etc.)

In answer to a question, Scott said
that 32-bit programs will run in the 64-
bit installation but run in a separate box.
The process is called “thunking.” Most
new software is now available in 32- and
64-bit versions, but more and more will
be available only in 64-bit versions, he
said. Some vendors are selling both ver-
sions in the same box, giving users a
choice. A specific version of Microsoft
Office, however, must be selected at the
time of purchase.

A family pack is available that al-
lows installation of Windows 7 on three
computers. It comes with three serial
numbers. One advantage of the pack is
that Windows 7 has a feature called
“Homegroup,” that easily creates home
networks, but only with other computers
running Windows 7, Scott said.

Discussing OEM vs. Retail versions,
the two said that the main difference is
that Microsoft supports the Retail ver-
sion and the person you bought the
OEM version from supports it. Industry
practice is that the seller will support
installation problems for free or a small
cost but will charge to fix problems
caused by the user (software that doesn’t
work, viruses, and so on), Scott noted.

Virtualized Windows will be the
subject of a coming SIG by Shalkey, but
the license allows the system to be in-
stalled on up to four virtual machines on
the same computer.

Windows 7 eliminates the Vista side-
bar, Shalkey said. Gadgets remain and
can be placed wherever on the desktop a
user wants them.

Aero Shake minimizes all Windows
except the active one when it’s jiggled
with the mouse. Aero Snap lets users
minimize, maximize and resize a win-
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dow by just dragging-dropping it to a
screen corner.

Program notifications appear in the
notifications area of the taskbar rather
than popping up on the desktop. They
can be read by right clicking on them.

Another new feature is the Action
Center, which shows system mainte-
nance and security information and sim-
plifies troubleshooting.

Jump lists are similar to History lists
already in many programs and can be
reached by right clicking on the pro-
gram’s icon. Their contents depend on
the program, but the idea is to show the
last several items opened and sometimes
actions that can be performed on them.

If you can’t remember where you
stored a file but know its name, you can
start typing the name in the search box
to find it.

At first glance, Libraries look like
regular folders, but each one is more like
an index of all the folders and any exter-
nal drives or other networked com-
puters. Windows 7 comes with Libraries
for documents, music, pictures and vid-
eos, but users can create them for any-
thing they want to.

Because of anti-trust issues in
Europe, some features have been deleted
from Windows, but they can be
downloaded and installed. The programs
that were left out or are new include
Microsoft Live Mail, Windows Live
Essentials and Microsoft Security Essen-
tials, which includes the new Microsoft
anti-virus program.

Shalkey is impressed with the new
WordPad, which doesn’t have spell
check but does allow changing of fonts,
type size and type colors. Scott noted
that it’s also possible to insert spread-
sheets and pictures in its documents. A
person could prepare a full publication
in Word Pad, Scott said.

The User Account Control, which
irritated so many Vista users, has been
toned down, Shalkey said. Vista pops up
lots of messages, and users are supposed
to say no to programs that try to install
themselves or make major changes that

(Continued on page 13)
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‘They’re here’ (written on Halloween night)

group of seemingly benign

Microsoft Techs communi-

cating with 5-year-old Carol

Anne Freeling in her par-
ents’ suburban California home via
static on the computer. Eventually they
use the computer as their path into the
house itself.

First, there are a few signs that the
Microsoft Techs have arrived: Carol
Anne carries on a seemingly one-sided
conversation with a computer that’s
turned on but has no Internet signal, an
earthquake occurs that only the Freel-
ings feel (which was caused by the Mi-
crosoft Techs leaving the computer and

entering the house), and
Carol Anne announces,
“They’re here.” The next
morning, e-mail automati-
cally downloads at break-
fast, photos edit and print
by themselves, and when
the mother, Diane, asks
Carol Anne, “What did
you mean? Who’s here?”
she answers, “The Micro-

Rick’s
rant

Smith

soft people.” At first, the
Microsoft Techs play harmless tricks
and amuse the mother, including moving
and stacking the OS software they have
bought over the years by date. Windows

More on Windows 7 ...

(Continued from page 12)

the user didn’t expect. Making changes
in the background is the way viruses and
other malware get installed. The func-
tion is still there but with fewer pop-ups

Asked if Windows Mail would be
moved during an upgrade installation,
Scott said he wasn’t sure.

Shalkey said a licensed, registered
copy of an earlier Windows version
must be on the hard drive to install an
upgrade version of Windows 7. An acti-
vated release candidate of Windows 7
suffices for the requirement, he said.

The minimum requirements for Win-
dows 7 are 1 Gig of RAM and a 1 Gig
processor, Scott said, and the software
will run on the minimum requirement.

Networking with other Windows 7
computers is easy, Scott said. Go to Start
> Right Mouse Click on Network, Prop-
erties to see what exists. The first time
you log onto a network, Windows 7 will
create it as a Public network. If the net-
work is your Home or Work network,
click on Private Network and change it
to the appropriate choice. If you have
more than one Windows 7 computer on
the network click on HomeGroup on the
left and create a HomeGroup as it will
make networking much easier. Home-
Group only works with Windows 7

computers.

The system defaults to Public Net-
work, which is more secure than the
home or business networks. Windows 7
interprets all the computers in a home or
business network as safe, while those on
the Public Network are not, Scott said.

All of the networked activities are
seamless, and Libraries can show all the
material on all the machines in your
HomeGroup.

3.1, 98, ME, 2000, XP, Vista and on the
top lies a new copy of Windows 7. Of
course, Diane must convince Steven that
night by showing him. He then an-
nounces that “Nobody goes on the com-

puter until I know what’s happening.”
During a rainstorm, a gnarled Apple
tree comes to life and grabs Robbie,
Carol Anne’s brother, through a win-
dow. However, this is merely a distrac-
tion used by the Techs to get Carol
Anne’s parents to leave her unattended.
Like a black hole, a shining light ap-
pears where the Windows 7 disk lies on
the DVD player that pulls everything
(Continued on page 14)

The new Media Center can play TV,
movies, music, pictures and even Netflix
movies. YouTube videos are Flash and
don’t work in Media Center. They are
normally played in your browser, Scott
said. No special card is needed for the
media center.

On the Net:
There are many Windows 7 sites on
the Net. These barely scratch the sur-

While all the data appears to be in face:

the same place, programs must be in-
stalled on each computer to be used. It is
possible to prevent specified files and
folders from being read for the libraries.

Another new feature, Problem Steps
Recorder, gives users a way to re-create
problems and record the steps that lead
up to them, thus making it easier for a
technician to figure out what’s wrong.
It’s opened from the Start menu; type
“psr” and it will start.

Devices and Printers, also available
from the Start menu, shows all the de-
vices attached to the computer. A device
that’s not working properly will be
marked with a yellow triangle. This area
speeds up troubleshooting, Scott said. It
doesn’t show ghost entries like XP does
for devices installed on more than one
computer on the network.

Paul Thurrott’s Windows Super Site
is at http.//www.winsupersite.com.

Microsoft has an introduction to
Windows 7 at

http://www.microsoft.com/Windows/
windows-7/what-is-windows-7.aspx?
CMXID=2120 win7.542B4639-E0B5-
4 4 9 D - A 4 4 F -
45660DD25D6D&WT.srch=1&CR_CC
=100249569&WT.srch=1&WT.mc_id=
Search&CR_SCC=100249569

The Microsoft Upgrade Advisor can
check your computer and tell you if it’s
suitable to run Windows 7. Download it
at  http://www.microsoft.com/windows/
windows-7/get/upgrade-advisor.aspx

A general site devoted to Windows 7
news and tips is at http://
windows 7news.com/




Page 14

The Outer Edge

More on Rick’s rant ...

(Continued from page 13)

from the room into it; however, only
Carol Anne was taken into the Windows
7 dimension. The Apple tree appears to
swallow Robbie whole, but he is res-
cued, and as the family watches Steven
pull Robbie out of the Apple tree, a tor-
nado of Linux users drags the Apple tree
into oblivion. They then realize that they
can’t find Carol Anne. They search the
entire house, including their new data
room, which is now extremely quiet and
dark, until Robbie hears Carol Anne
through the computer.

Steven reluctantly calls on a group of
Computer Techs from Ventura County
Computers: Dr. Lesh (Rick Smith),
Ryan (Toby Scott), and Marty (Michael
Shalkey), who are awestruck by the
manifestations they witness. With the
VCC Techs present, the Freelings show
them things they’ve never before seen.
They open the door to the data room to
reveal DVDs and other objects flying
around by themselves and disembodied
laughing voices reverberating through-
out the room. Previously, one of the
techs described a PC taking seven hours
to boot, calling it “[F]fantastic. Of
course, this would never register on the
naked eye.” After they see the Freelings’
house, they are all humbled.

Over coffee (and a coffee urn that
moves by itself), techs explain to the
Freelings the difference between XP and
Windows 7. They determine that indeed,
it is Windows 7 they are experiencing.

It turns out that the older operating
systems have left this life but have not
gone into the “Light.” They are stuck in-
between dimensions, watching their
loved ones still use PCs with this new
OS, but feeling alone. Carol Anne was
born with a PC in her crib. Only 5 years
old, she gives off her own life force as
she nimbly moves the mouse. It distracts
and confuses the old OSs, who think
Carol Anne is their salvation. Hence,
they take her.

What is also in the other dimension
is a malevolent spirit, what techs call
“The Beast.” It exploits the fact that the

old OSs have security vulnerabilities
that leave them confused and lost, un-
able to boot and run properly, and uses
Carol Anne as a distraction so they can-
not move on into the Light. After the
group witnesses several malware epi-
sodes where they hear Carol Anne talk-
ing to Diane through the PC, see adver-
tisements, and hear the unending ads of
fake software fixes, which subsequently
injures Marty, the techs leave, admitting
they need more help. Carol Anne’s elder
sister, Dana, shaken and overwhelmed,
leaves to stay with friends. The Freel-
ings also send Robbie to his grand-
mother’s house for his safety.

When techs return, they bring a
magical disk, called the Bart PE, who
informs Diane that her PC is “alive and
in this house.” She also explains the
malevolent malware in the house to
Diane, saying, “it lies to her and tells her
things only a child can understand. To
her, it simply is another child. To us, it
is the Beast.”

They realize the entrance to the Win-
dows 7 PC is through the children’s PC,
and the way out is through the Internet.
By tying a rope around a live person
who can enter, and presumably exit the
other side, with enough time to grab
Carol Anne, they could bring her back.
Diane is the only choice to go. What
happens next is a terrifying sequence
where Diane gets Carol Anne and Bart
PE coaxes the agonized old OSs away
from Carol Anne to the real Light, Win-
dows 7 (during this, Steve panics and
pulls on the rope, causing the Beast to
appear right in front of him). Diane falls
through the living room ceiling clutch-
ing Carol Anne and bearing new streaks
of grey hair, presumably from fright;
both Diane and Carol Anne are also cov-
ered in technobabble. After both are
revived in the downstairs bathtub,
BART PE pronounces that “this house is
clean.”

Unfortunately, though the old OSs
have seemingly moved on, the Beast
hasn’t, and wants revenge. On their final
night in the house, when they are almost
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packed up and ready to go, the Beast
returns to reclaim what he believes is
his: Carol Anne. This time, the Beast
does his own dirty work and comes after
Carol Anne personally with a malicious
virus attack.

While Robbie and Carol Anne are
getting ready for bed, Robbie's notebook
comes to life and pulls him under the
bed to look at porn. Diane, in the other
room hears her son’s screaming voice
and tries to investigate but is pulled
against the wall and ceiling by a desire
not to see what her son is looking at.
Robbie manages to defeat the notebook,
but a strange, mouthlike Internet porn
portal appears in Carol Anne’s closet
and attempts to pull the children in yet
again.

Diane tries to get to her son and
daughter but runs into the Beast himself,
in the form of a snarling, skeletal back-
door Trojan virus. He blocks Carol
Anne’s and Robbie’s Internet access and
throws ads at her, causing her to click
endlessly on the PC. Diane runs to the
backyard to seek help from her next-
door neighbors, but slips into the endless
useless search on the Internet, which is
now infested by ads as well as financial
offers, which burst out of the browser
and open. Her neighbors hear the com-
motion and arrive to help Diane out of
the endless search, but they refuse to
enter the house with its PCs now blazing
with windows 7 energy, so Diane runs
back into the house alone to get Robbie
and Carol Anne.

Through skill and luck, the Freelings
finally escape the house, but not before
the anger of the Beast reveals the reason
for the old OS’ being there in the first
place: Old CDs, manuals and how-to
books begin exploding out of the ground
throughout the neighborhood. When the
neighborhood was first built the real
estate developer Steven worked for
moved an old Gateway Store that was on
the location. In reality, in order to save
money, they moved the store but left all
the old software licenses, installing Win-

(Continued on page 15)
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Ubuntu 92.10: Karmic Koala

By Bill Wayson

bwayson@gmail.com
ct. 29 saw the release of a
new version of Ubuntu, 9.10,
the latest in Ubuntu’'s regu-
lar six-month upgrade cycle.
This release, just as earlier ones, is ea-
gerly anticipated by the numerous users
of Ubuntu worldwide. Since the CIP-
CUG computer runs under Ubuntu,
we’ll look at what’s new in 9.10. There
are many more new features than those

Penauin’s listed here added in

ng 9.10, but they are of
Lair ; o7

interest primarily to

those with special needs

and situations. Those

listed below are more
likely to be of interest to
the majority of com-
puter users who just
want to get something
done.

Ubuntu users are

brought up to date with

Page 15

the latest versions of the system and user
interface software. Ubuntu ships with
Linux kernel 2.6.31; the default file sys-
tem for new installations is ext4; Grub2
is the boot manager installed in new
installations, providing support for re-
cent motherboard technology; and a new
architecture for handling specific hard-
ware features, such as power manage-
ment, laptop hot keys, storage devices,
and cameras, has been adopted. The

(Continued on page 16)

Smart Computing tips and fun facts

Reprinted with permission from
Smart Computing. Visit http://
www.SmartComputing.com/Groups to
learn what Smart Computing can do for
you and your user group.

Display issues: If the images on
your computer screen are fluctuating
(one second they’re there, and the next
they’re not), check your connections. If
the connection between your PC and
your monitor isn’t perfect, the data may
have difficulty making its way from the
computer to the screen. Take a look at
the cable running between the PC and
the monitor. Is it bent or crimped? Are
the pins not straight? Are the connectors
loose? If you answer yes to any of these
questions, you may need to replace or
secure the cable.

Dry out that cell phone: Cell
phones are tougher than they look. Al-
though most mobile phone manufactur-
ers don’t claim that their phones are

water-resistant, many phones can un-
dergo a quick dunk. “The key is to mini-
mize the time the phone is wet and the
time the battery is on the phone while it
is wet,” says John Wernecke, spokesper-
son for Motorola. “Remove the battery.
Give it time to dry before replacing the
battery. Some have reported that wrap-
ping the phone in a thick towel to absorb
liquid works very well.”

In our own experience, we’ve found
that phones often need as much as 48
hours to completely dry. Once you’ve
dried and then reassembled the phone,
power it on and place a test call to make
sure the phone works properly. If your
phone displays problems (or doesn’t
power on at all), it’s probably time to
find a new phone.

Sunglasses for your camera: If
you’ve ever tried to take pictures on a
sunny day and noticed bright reflections,
it might be helpful to get your camera a
pair of sunglasses. In a pinch, you can

More on Rick’s rant ...

(Continued from page 14)

dows 7 right on top of them, thus dese-
crating the old, still useful software li-
censes. And because of the upgrades to
the PC (installing the new Windows 7
directly over the licenses) the old OSs
came at this point of time.

As the Freelings flee down the street
in their car, the Beast is so angry that the
PC implodes into the other dimension as
stunned neighbors (including Steven’s
boss) look on.

The family checks into an Internet-
free hotel for the night. Not wishing to

use average polarizing sunglasses held
over a camera’s lens to help reduce
glare. A better option, however, is to use
a polarizing filter that works the same
way, but that is better suited to your
camera. Regardless, you’re sure to take
better pictures by reducing glare

To ensure CIPCUG receives credit
for mew subscriptions and renewals,
always subscribe and remew using the
Subscribe or Renew Today! feature
available within the User Group portion
of the Smart Computing Web site. From
here, select us from the drop-down list
provided to ensure we received credit
for the subscription order.

You can also call 800-733-3809 to
subscribe or renew and give us credit by
telling the representative you want us to
receive credit for the order.

Following these instructions will
ensure that we get as many free sub-
scriptions as we possibly can.

tempt fate, Steven puts the notebook PC
outside their room.

The author would like to thanks
Wikipedia for the story outline of the
1982 feature film “Poltergeist” whose
story outline inspired him on this spooky
night.
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default desktop environment, Gnome,
has been updated to 2.28, its latest ver-
sion, which includes several new applets
of its own. Most of these features are of
no interest to most computer users since
they simply keep the computer running.
Suffice it to say that Ubuntu 9.10 in-
cludes the latest and greatest system
software.

On the user experience front, users
will notice many welcome enhance-
ments. Boot time, which was very quick
under Ubuntu 9.04, is made faster still
under 9.10 by converting to “Upstart”
boot jobs. The time it takes for a freshly
started computer to become usable is
impressively short. Shutdown time is
even shorter. Firefox, the standard Web
browser, is now at version 3.5.4, and
updates of Firefox can be expected to
keep pace with those coming from the
Mozilla community. Ubuntu updates to
3.0 the default office application suite,
OpenOffice.org. (Admittedly, OpenOf-
fice.org 3.1 is available — this may be
an instance of Ubuntu following the
long-held Debian philosophy of favoring
stability over cutting edge.) Ubuntu 9.10
ushers in simple, end-user support for
cloud computing. By taking advantage
of the new “Ubuntu One” feature, all
users have available up to 2 GB of data
storage at an Ubuntu-hosted Internet-
accessible site. Additional storage can
be had with a monthly subscription.
Ubuntu One makes it simple to share
files with any computers, yours and your
friends’, who have access to the Internet.

System administration has improved.
Users now find and install new software
through the new “Ubuntu Software Cen-

2

ter.” Applications are grouped under
categories such as Education, Games,
Sound and Video, Graphics, and Pro-
gramming and Office, making it easier
to find a solution for a particular need.
Once you choose to install an applica-
tion, the Software Center takes care of
installing everything required for the
program to run properly. The included
firewall configuration tool, Uncompli-
cated Firewall, now allows you to con-
figure different firewalls (rule sets) for
different network interfaces (such as an
Internet-facing card and a home net-
work-facing card), and to filter data as it
leaves your computer. You now can
disable the loading of kernel modules
(aka drivers) after your computer has
finished booting, providing an additional
layer of protection from certain types of
malware, like root kits. And once dis-
abled, loading kernel modules cannot be
re-enabled without rebooting the com-
puter.

Ubuntu 9.10 showcases its commu-
nity’s dedication to creating a simple,
pleasurable, and functional computer
end-use experience. Canonical and the
Ubuntu community want its operating
system to just work, and in many, many
instances Ubuntu does just that. This
latest release should help Ubuntu remain
one of the most popular Linux distribu-
tions, especially among home computer
users.

Now may be the time for many more
computer users to consider Ubuntu.
Now that Windows 7 is available, there
will be more pressure to convert from
Windows XP. Those Windows users
who are considering upgrading their
existing computer to Windows 7 may
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want to give Ubuntu a look. Ubuntu
makes this simple and completely safe
by providing a try-it-before-you-install-
it “live” version of Ubuntu on each Ub-
untu CD. Just boot from the CD, accept
the default boot option, and see how
Ubuntu looks and runs on your PC.
Installing Ubuntu alongside an existing
Windows installation is simple. Since
using Windows 7 and upgraded applica-
tions effectively itself presents a signifi-
cant learning curve, you may just want
to learn Ubuntu, gain a stable, well-
supported operating system and applica-
tion set, and save yourself some signifi-
cant dough. Those who are considering
an upgrade to Windows 7 by purchasing
a new computer with it preinstalled can
consider purchasing a computer with
Ubuntu preinstalled. Several major com-
puter manufacturers, including Dell, HP,
Acer, and Toshiba, offer and support
computers with Ubuntu already installed
for you.

If you have questions or would like
to learn more about Linux and FOSS,
come to the November Linux SIG meet-
ing on its new date (the fourth Tuesday
of each month), Tuesday, Nov. 24, at
6:30 p.m. at Ventura County Computers
in Ventura. The CIPCUG Ubuntu com-
puter will be updated during the meet-
ing, during which time we will answer
questions about Ubuntu, Linux, and
FOSS. Come see how well the update
goes. See the CIPCUG Web site for
more information.

If you have a question or topic you
would like the Lair or Linux SIG to
cover, drop me a line at bway-
son@gmail.com. Until next month,
happy computing.

Back up, back up, back up ... and then

be sure it worked.

test the backup to
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Site has information on electronic waste

his is merely a reminder that
our Electronic Waste Recy-
cling information is still on the
Web site, located below the
Calendar Information. David Minkin has
done a great job in making this informa-

: tion available to wus.
Bits & Bytes Please make use of it.

Guess what? The
SIG SIGNUP sheet has
been fixed. Toby has
been very busy, but he
promised to check the
page out. It is one that I
don’t know anything
about because it is com-

Long

plicated and I don’t know what makes it

work. To sign up to be informed of com-
ing SIGSs, just check the club’s Web
page under “Latest Revisions Box.” At
the bottom of the box “List informa-
tion,” check the SIGINFO list and fill
out the information and hit Submit (or
Send).

Toby and Rick are considering the
possibility of another CIPCUG Flash
Drive run for the Christmas holidays.
They are looking into the possibilities to
see what options are available and at
what price. Even if we proceed, they
will not be available before the Decem-
ber meeting. This is just a Christmas
suggestion. A flash drive to store valu-
able data is always useful!

Excel and Word tips

This item is copyright 2009 by
Sharon Parq Associates Inc. and are

to determine if the lowest value in the
range is zero. If it is, then the SMALL

reprinted by permission. Thousands of function is used to derive the lowest

free Microsoft Excel tips can be found
online at http://excel.tips.net.

Excel: Determining high and
low non-zero values

There may be times when you need
to derive the smallest (or largest) value
from a range, unless the smallest (or
largest) value is zero. For instance, you
might have a range of values such as {0,
3, 1,4, 2}. In this case, the lowest value
is zero, but the value you really want
returned is 1.

There is no intrinsic function within
Excel to return a value as stipulated
here. However, you can create a formula
that will do the trick. Assuming that the
range of values you want to analyze are
in C4:C8, the following formula will
return the lowest non-zero value:

=IF (MIN(C4:C8)=0,SMALL
(C4:C8,COUNTIF
(c4:c8,"=0")+1) ,MIN
(ca:cs8))

This formula uses the MIN function

value, excluding the zeros. (The COUN-
TIF function returns the number of zeros
in the range, and therefore tells SMALL
which item from the range to pick.)

A small change to the formula al-
lows it to be used to return the largest
non-zero number in a range:

=IF (MAX (C4:C8) =0, LARGE
(C4:C8,COUNTIF
(C4:C8,"=0")+1) ,MAX
(ca:c8))

These formulas will work for any
range, unless the range is made up en-
tirely of zeros. In that instance, a
#NUM! error is returned.

This item is copyright 2009 by
Sharon Parq Associates Inc. Reprinted
by permission. Thousands of free Micro-
soft Word tips can be found online at
http://word.tips.net.

Word: Splitting a table
Word provides a powerful table edi-
tor that allows you to create and modify

If you missed Toby and Michael’s
presentation last month on Windows 7,
you really missed a good one. Win 7 is
the topic of the season. Many of us are
operating with equipment that is sadly
outdated, and by more than a few years.
I’m sure mine is over 7 years old. The
only thing that makes me hesitate is I
can’t find an “install” fairy to install all
my programs and fill out those horren-
dous registration forms. NOW IS THE
TIME TO REBUILD! If you find any
unoccupied Fairies around, please let me
know.

Have your run your spyware
programs lately?

data in tabular format. If you are work-
ing with large tables, there may be times
when you need to split a table in half. To
do this, follow these steps if you are
using Word 2007:

1. Position the insertion point any-
where in the row you want as the first
row in the table that is split off the larger
table.

2. Display the Layout tab of the rib-
bon. (This tab is only visible if your
insertion point is within a table.)

3. Click the Split Table tool, within
the Merge group.

If you are using an older version of
Word you can split a table by following
these steps:

1. Position the insertion point any-
where in the row you want as the first
row in the table that is split off the larger
table.

2. Choose Split Table from the Table
menu.

The result is that Word inserts a Nor-
mal-formatted paragraph prior to the
table row in which your insertion point
was placed. The two resulting tables can
now be treated independently.
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Acronis releases True Image Home 2010

(Gene Barlow, our November pre-
senter, sent this article on True Image
Home 2010, one of the programs he
represents through User Group Rela-
tions. — Editor.)

By Gene Barlow

User Group Relations
Copyrighted October 2009

cronis recently announced a

significant new release of

their top rated backup utility,

Acronis True Image Home
2010. This new release adds many prac-
tical new features to a product already
packed with excellent function. The
product may be ordered now on our se-
cure web site at www.ugr.com/
Truelmage.html for only $29 (as a
download) or $29 plus shipping (on a
CD).

Here are a few of the new features
included:

Support for Microsoft Windows 7
— Thoroughly tested to run on the new
Windows 7 operating system. It also
delivers more comprehensive functional-
ity over Microsoft Windows 7 backup
capabilities. So, if you are planning a
move to Windows 7 in the future, you
need to backup first with True Image
2010.

Acronis Nonstop Backup — Near-
CDP (Continuous Data Protection) is
now available to Acronis True Image
Home users. You will be able to revert
your documents to previous states in
time. This may come in handy when
you accidentally deleted an important
document or made some corrections that
turned out to be wrong and you need to
return the document to the state in which
it was, for example, two weeks ago.
When you need to recover a file, a Win-
dows Explorer-like browser with inte-
grated search makes searching for a file
you need to recover very easy. But Ac-
ronis Nonstop Backup is much more
than a versioning tool. It also provides
for recovering your system if you ever
need that.

Online backup — You can make

your critically important data much
more secure by storing it off-site. Be-
cause files are stored on a remote stor-
age, they are protected even if your
computer gets stolen or your house
burns down. So the risk of data loss as a
result of fire, theft, or other natural dis-
asters is practically eliminated.

And you can safely recover any cor-
rupted, lost or deleted files on your
computer. Integrating online backup into
Acronis True Image Home provides a
single solution for all your data backup
needs.

Powerful scheduler — The sched-
uler became more powerful and flexible.
We expanded the set of already existing
scheduling options. The new scheduler
allows you to specify the date when a
scheduled task should run for the first
time. While scheduling a monthly task,
you can use a month calendar for speci-
fying the date (e.g. 1st day of the month)
or dates for running the task (e.g. on
10th, 20th, Last day of the month). If
you do not need to run a scheduled task
for some time, but intend to use it again
in the future, you can disable the task for
the time being and then re-enable it
when required. So it is not necessary to
re-create the task from scratch. You can
clone a scheduled task and then intro-
duce some minor changes into the dupli-
cate. This may be useful when creating
several similar tasks. In combination
with a selected backup method and auto-
matic consolidation rules, the scheduler
allows implementing various backup
strategies.

Selective validation — Earlier ver-
sions of Acronis True Image Home
could validate only a whole backup ar-
chive. Sometimes this may be inconven-
ient. Suppose, you have a full backup
archive with a size of 20GB and a long-
ish chain of differential backups having
sizes of several gigabytes each and
amounting to 100GB. In this case Ac-
ronis True Image Home validated the
whole 120GB archive and this could
take quite a long time. Now the program

will validate just a single selected
differential backup and the full one.

VHD format support — Virtual
Hard Disk (VHD) is a file format con-
taining the complete contents and struc-
ture representing a hard disk drive.

Furthermore, Windows Backup util-
ity included into Windows Vista (except
Home editions) and Windows 7 operat-
ing systems now uses this format for
backing up an image of the system hard
drive when users select the “Complete
PC Backup” option. Acronis True Image
Home can convert vhd files into tib files
and vice versa, recover operating system
from vhd files, and even boot from vhd
images of Windows 7.

Booting from tib images containing
Windows 7 — Users of the Windows 7
Enterprise and Windows 7 Ultimate can
boot from a tib image containing a
backup of their system partition. This
will allow testing the bootability of the
backed up system without actual recov-
ery. If the operating system boots from
the tib file, then it will definitely boot
after recovery from that tib file.

Try & Decide New features — Try &
Decide now can protect your system not
only to Acronis Secure Zone, but to the
protected volume itself, or any other
volume. Now users can protect not only
a single system partition during Try &
Decide session, but as many volumes as
needed. This is very handy when the
applications being installed make
changes on two volumes and in many
other cases.

Acronis True Image Home 2010 is
available from us for only $29 (as a
download) or $29 plus shipping (on a
CD) and you get a full new license of
the product and not an upgrade license.
If you order the product on a CD, you
also get our Perfect Backup Approach
tutorial to help you understand the best
way to do backups. There is also a step
by step Starter Guide for installing and
using the product for the first few times.
The full Acronis User Guide is also on
the CD for your use. In addition, I try to
help my customers when they have
questions about True Image. You also
have the normal (first 30-days free)

(Continued on page 19)
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Computing 101: Some tips for new users

By John Weigle

Jjweigle@vcnet.com
made a quick Web search to try to
find the most common uses for a
computer, and while T couldn’t
find anything specific to home
users, I expect that the following list for
types of computer activities at work
from October 2003 have not changed
much:

Internet or e-mail, 75.2 percent.

Word processing or desktop publish-
ing, 67.6 percent.

Spreadsheets or databases, 64.2 per-
cent.

Calendar or scheduling, 56.8 percent.

Graphics or design, 29.7 percent.

Programming, 16.4 percent.

(The figures come from a govern-
ment study at http://www.bls.gov/opub/
ted/2005/aug/wk5/art05.htm.)

The first two categories — Internet
or e-mail and word processing or desk-
top publishing — are probably equally
popular for home users. Almost every-
one with a computer, I think, checks the
Internet and wuses e-mail and writes
something on the computer, even if it’s
only shopping lists.

On the other hand, I doubt that 16.4
percent of home users do any program-
ming.

I’d like to know how you use your
computer so I have some idea what

should be covered in these articles. If
you have ideas or questions you’d like
me to seek answers for, please let me
know.

Printing

Printing is usually simple. Open the
file menu, click on print, and, assuming
it’s on and connected to the computer,
the printer starts to spew out whatever
you asked it to.

Then there are the times it doesn’t.

I had one of those while preparing
this issue of TOE. The green and orange
lights on the printer came on, the green
light went out, and the orange light
stayed on. I couldn’t see a message in
the printer’s message box, so I started
checking connections, uninstalled and
reinstalled the printer, updated its soft-
ware and said some things I can’t print
here. Bad words don’t make a printer
print. I searched the Web and found a
message about toner levels, which I had
tried to check but couldn’t. Finally, I
looked at the message box again, jug-
gling a light closer to it so I could read
the message.

It needed black toner.

The first rule of troubleshooting:
Check the obvious first. Making sure it’s
plugged in, turned on and connected to
the computer might be first on that list,
but checking the toner is an obvious
possibility that should be right up there.

More on True Image ...

(Continued from page 18)

technical support through Acronis to
assist you. You can rder your copy of
Acronis True Image Home 2010 from us
at www.ugr.com/Truelmage.html. Make
sure you use the order code of UG-
TIH2010 when placing your order.

If you are a current user of Acronis
True Image, then you will want to get
this new release and put all of the new
features to work for you. If you have not
started a backup plan for your computer,
then this is the best product to accom-

plish this important task on your com-
puter. In either case, place your order
today so that you can enjoy this new
product soon. If you have any questions
about this article or Acronis True Image
Home 2010, please send them to sup-
port@ugr.com. I look forward to helping
you if I can.

Barlow’s contact information: Gene
Barlow, User Group Relations, , P.O.
Box 911600, St. George, UT 84791-
1600; gene(@ugr.com; www.ugr.com.

(Barlow generally provides copies of

Related rule, if you have the room in
your computer area: Put the printer low
enough that you can easily read its mes-
sages.

As long as we’re talking printing,
here are a couple of things to know.

Usually, you can just accept the de-
fault settings on your printer, but some-
times they aren’t satisfactory. For in-
stance, instead of a vertical page like
this one, which is called portrait, you
might need a horizontal (landscape)
page.

To do that, open the File > Page
Setup menu. A box will come up that
lets you pick Portrait or Landscape.
Click in the correct radio button, and the
change is made.

If you want to save on color ink, you
can print your documents in black and
white. This might change from one pro-
gram to another, but in Word, go to File
> Print and select the printer you want to
use. Then click on Properties > Color
and click the radio button for “Print in
grayscale.” That cuts your use of color
ink or toner.

To save on the black ink or toner,
too, chose Options on the same page you
picked the printer. Pick draft output,
which results in lighter printing.

To set draft quality as the default in
Word go to Tools > Options > Print Tab
> Printing , select Draft output and click
OK.

the two Acronis products at his webi-
nars. — Editor)

This is one of a series of technical
articles that I distribute to those that
have subscribed to this newsletter. You
can subscribe at www.ugr.com/
NewsletterRegistration.html. Watch for
them and learn more about your com-
puter and its hard drive. If you do not
want to receive these newsletters, simply
reply and ask to have your name re-
moved from the list and I will do so im-
mediately.
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‘Missing Manual’ book
for Windows 7 due soon

he computer sections of local bookstores are ex-
panding with books on the newest Apple and Mi-
crosoft operating systems. Two of what I expect to
be the most popular books are scheduled for re-
lease in December: “Windows 7: The Missing Manual” and
“Switching to the Mac: The Missing Manual, Snow Leopard
Edition,” both by David Pogue. According to his biography

Editor’s | &t http://www.oreillynet.com/pub/au/347,
corner Pogue has 3 million books in print (that’s
books, not titles). He’s the author or co-author
of seven “For Dummies” books and started the
“Missing Manual” series, which now has 100
titles, in 1999. His Web site is
www.davidpogue.com. The books are pub-
lished by O’Reilly, which offers a discount to
user groups members (see the regular ad in this
issue or on the CIPCUG Web site. If you’ve
switched to Windows 7 and found a favorite

Weigle

book on the subject, please send me a review
that notes some of the best points so other members can
learn from your experience. If you don’t believe in the words
on paper mode and use a Web site instead, pass that informa-
tion along, too.

In the past few weeks, I’ve seen references to some
problems with Windows 7 installations (not to mention the
Apple ads suggesting that, if you’re going to switch operat-
ing systems anyway you should switch to Macintosh). As
Toby and Michael noted during their presentation, most peo-
ple upgrade to a new operating system when they buy a new
computer rather than moving up from an existing computer.
No matter how you upgrade, you know it will take a certain
amount of time even if you start with a brand new system.
You have to back up and restore all your data (unless you’ve
decided this is the time for a massive housecleaning, and
you’re dumping everything before the new computer) and
install all the software you plan to use. And there will proba-
bly be some learning curve whether you go to Windows 7,
Snow Leopard or some form of Linux.

EEE

You probably noticed that this is another 24-pager. A
couple of regular features ran longer than usual, and I added
the new Word and Excel tips promoted on page 1.

Jeff Levy’s column hasn’t appeared in the past two issues
because I haven’t heard from his producer, who gives us
permission to reprint each column. I hope that we’ll be able
to bring the lessons back soon.

As always, contributions are welcome from all members
in the form of letters to the editor, short tips on your favorite
programs or hardware or longer articles on computer-related
subjects. — John Weigle, editor

The Outer Edge

Treasurer’s
report for

September 2009

By Art Lewis

treasurer@cipcug.org
9-1-2009 through
9-30-2009
Category Description
INFLOWS
Coffee income
Donation
Membership Income
New Members 55.00
Renewals 295.00
TOTAL MEMBERSHIP
Raffle

TOTAL INFLOWS

OUTFLOWS
Corporation Expt.
ISP Expense
Rent Paid
TOE
TOTAL OUTFLOWS
OVERALL TOTAL

Unrestricted Funds
Restricted Funds

Bank Balance 9-30-09
Year to Date Income
Year to Date Expense

67
27
8,
1,
_1’

November 2009

Lewis

-7.00
122.00

350.00
-45.00

419.10

20.00
122..00
150.00
195.65
487.65
-68.55

481.86
000.00
481.86
905.59
766.21

2009 contributors to The Outer Edge

Your name can appear
here, too. Share your knowl-
edge with other members by
sending an article, letter or
computer tip to edi-

tor@cipcug.org.

Ken Church
Jerry Crocker
Rick Curry
Bob de Violini
Jeff Levy

Art Lewis
Helen Long

Diane Mortensen
Sharon Parq Associates

Inc.

zin

Toby Scott

Michael Shalkey

Smart Computing maga-
e

Marjie Tucker (APCUG)
Bill Wayson

John Weigle

Paul Westefer

Ira Wilsker (APCUG)
Albert Wolfkiel (IEEE)
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Membership report:

Is it time to renew?
By Ken Church

email address: membership@cipcug.org

The Outer Edge Page 21
November 2009 renewals payment due:
Mbr# |Last Name |First Name | Pd to Dt
0388 |Armstrong Bob 200911
1074 |Chaison Doris 200911
1061 |Churchyard |Martha 200911
0915 |Clayton Phil 200911
CHURCH 159447 |Coon Donn 200911
0635 [Godwin John 200911
0945 |Gorelik Donn 200911
0946 |Gorelik Patricia 200911
1212 [Hollander Gary 200911
0905 |Knauer Hedy 200911
0789 |Knauer Wolfgang 200911
0272 |Provart Robert 200911
0542 |Salisbury Wayne 200911
1194 [Tsutsui-Trujillo |Sandy 200911
0046 |Wood Bart 200911

New Members: Wanted

Attendance at the October 2009 general meeting:
82 members and guests

Total membership: 211

MEMBER RENEWAL INFORMATION
$30 for single membership,
$35 for two or more family membership.

NEW MEMBER INFORMATION

$40 first year for single membership,

$55 first year for two or more family member-
ship in same household.

Please send your renewal payment to:
CIPCUG MEMBERSHIP

Members’ classified ads

P.O. BOX 51354
OXNARD, CA 93031-1354

Or bring your payment to the sign in table for
the November 21, 2009 Meeting.

September 2009 renewals payment due:

Mbr# [Last Name First Name | Pd to Dt
0373 |Houle Robert 200909
0145 |Lee Bill 200909
1036 |Smith Howard 200909
October 2009 renewals payment due:

Mbr# [Last Name First Name | Pd to Dt
1107T |Carlson Gordy 200910
1049 |Duncan Gerald 200910
0990 [Mehr Steve 200910
0942 [Mickey Barbara A. | 200910
1209 |Nachian Paul 200910
1165 [Taggesell Bernice 200910

Classified ads are free to members. Each ad is limited to
105 characters, including spaces and to one ad per member
per month. Copy has to be to John Weigle, editor of TOE
(editor@cipcug.org), within the week after the regular meeting.
Otherwise, the ad is held to the following month.

For sale

1) PC Tower, Intel Pentium MMX-CPU, 233MHz. 2.0 GB
HDD, 24X CD-ROM, 1.44 MB 3.5" HD, Win 98SE, Monitor
$20/0BO

2) D-Link Wireless Print server DPR-1260 $10/0BO

3) Microsoft Keyboard, ergonomic $10/0BO

4) Microsoft Serial Mouse $5/0BO

5) One HP 22 Tri-color inkjet cartridge (recycled-refilled),
$6

6) Two HP 27 black inkjet cartridge (recycled-refilled), $6
each

— David Minkin, ddave@cipcug.org

HP DeskJet D 4360 Printer. New. Original box unopened.
$25.
— Jerry Kiess, jerry105@dslextreme.com, 805-985-5636

Wanted

Have a small flash drive that you don’t use? | could make
good use of any 128 MB flash drives you care to donate for
next year’s volunteer income tax program. — Art Lewis

Other categories as needed
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F1—Your Help

(Revised Sept. 7, 2008)

COMMUNICATIONS/INTERNET (GENERAL)

World Wide Web

DATABASES
Access

DOS

E-MAIL
Outlook
Outlook Express
Thunderbird

GRAHICS PROGRAMS
IrfanView

Paint Shop Pro

Photo Shop Elements
Print Shop

SPREADSHEETS
Microsoft Excel

WORD PROCESSING
Microsoft Word
WordPerfect

WINDOWS
Windows 98, 95
Windows 2000
Windows XP

DM

BR

RP

MS
BR, DM
MS

MS
DM
BR
BR

DM

DM
DM

DM, MS (98)
BDV
DM

The Outer Edge

Key

November 2009
Initials Name (805)
BDV Bob de Violini  rjddev@gmail.com
BR Bill Robinson ~ 389-2997 (b)
bill@bzus.com
DM David Minkin ~ 469-6970 (cell);
484-2974 (home);
dddave@cipcug.org
MS Michael Shalkey mshalkey@cipcug.org
RP Robert Provart  498-8477 (b)

Phone: (d) = days; () = evenings; (b) = both

If you would like to volunteer to help others, please send
your contact information and programs you’re willing to
help on to editor@cipcug.org.

WEB HELP SITES

Annoyances Central blog (from authors of the O’Reilly
Annoyances series, including Steve Bass):
www.annoyancescentral.com/

Steve Bass TechBite Newsletter: www.techbite.com/

DSL reports: www.dslreports.com

Steve Gibson: www.grc.com/

Kim Komando: www.komando.com

Leo Laporte: www.leoville.com/

Jeff Levy: www jefflevy.com

Linux distributions: www.DistroWatch.com

Microsoft: www.microsoft.com/

Microsoft Windows XP The Official Magazine (UK):
www.windowsxpmagazine.co.uk/

Microsoft Windows Vista The Official Magazine
(UK): /www.windowsvistamagazine.com/US/

Online safety tips: www.OnGuardOnline.gov

PC Pitstop: www.pcpitstop.com/

PC World: www.pcworld.com/

Recalled products: www.recalls.gov

SANS Institute — Computer Security Education and
Information Security Training: www.sans.org/

Smart Computing: www.smartcomputing.com/

Spyware Warrior: www.spywarewarrior.com/

User Group Relations (Gene Barlow): www.ugr.com/

Ventura County Computers (Rick and Toby’s shop):
WWwWw.vccomputers.com

Virus Bulletin: www.virus-bulletin.com/

Windows Secrets: ww.windowssecrets.com/

ZD Net spyware blog: www.blogs.zdnet.com/Spyware

If you have a favorite help site on the Web, please for-
ward it, so we can expand the section. If you find a link
that doesn’t work, please tell us that, too.
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Every month, members of the
Channel Islands PC Users Group have
access to:

¢ The Outer Edge newsletter, which
includes a list of members willing to
help other members.

¢ The general meeting, featuring a
question-and-answer session and
program on new software or hardware.

# Special Interest Groups — special
meetings held several times a month.

¢ Door prizes at the regular
meeting.

Other benefits include:

# Special user group discounts on
books and software.

¢ An Internet service provider at a
large discount (see next column).

¢ A flash drive containing many
useful freeware programs.

¢ A chance to make friends with
people who have similar interests.

¢ The ability to put your knowledge
to good use by helping other members.
The whole concept of user groups is
members helping members.

Please clip the coupon below and
send with payment to CIPCUG-

The Outer Edge
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Why join Channel Islands PC Users
Group (CIPCUG)?

Membership, P.O. Box 51354, Oxnard,
CA 93031-1354.

Please make checks payable to
CIPCUG.

Dues for new members
Individual member, $40.
Family membership (same

ISP = $15 Monthly
Signup nuow!

address), $55.
Renewals are $30 and $35 per
year respectively.

CIPCUG members are eligible to
sign up for the group’s Internet service
provider (ISP) at the low price of only
$15 per month plus a $15 processing fee.

To sign up, contact one of the club’s
techies (see next column). Call one of
them you may know or one in your area,
and they will be glad to provide you
with the details necessary for signing up.
Checks should be made payable to
CIPCUG and sent to Treasurer, c/o
CIPCUG, P.O. Box 51354, Oxnard CA
93031. Don’t forget to include the $15
set-up fee in your first sign-up check.

You may make payments in three-
month, six-month or annual increments.
We also give a 12-month subscription if
prepaid in advance at the 11-month price
of $165. Many of our club members are
electing to do this to keep Helen from
nagging them for money. Renewals can
also be mailed to Treasurer; just be sure
to mention the dates that your check is to
cover.

There is no program to install; you
will use programs that are already on
your computer. It’s simple to talk you
through the set-up, but if you’re the least
bit timid about setting up your computer,
a club member will come to your house
and make the necessary arrangements.
Our agreement will also give you a 5
MB Web page allowance.

CIPCUG INTERNET SERVICE
TECH TEAM
Helen Long, 642-6521
helen@cipcug.org
David Minkin, 469-6970 (cell), 484-
2974 (home)
dddave@cipcug.org
Bob Thompson, 647-2287

Name:

CIPCUG MEMBERSHIP
APPLICATION Phone (Home): (Work)
Amount enclosed: E-mail address:
Please Print the following information: User level: Novice ; Intermediate ; Advanced

Can you help the club as a volunteer? If so, what would you
be interested in working on?

, State:

Member #
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The Outer Edge

Channel Islands PC Users

Group Inc.

P.O.Box 51354
Oxnard, CA: 93031

DATED MATERIAL
Please Do Not Delay

DUES REMINDER

If the number above your
name is 200911, your
membership dues are
payable in November
2009.

NOVEMBER 2009 MEETING

November 2009
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Saturday morning, Nov. 21,
at the Boys & Girls Club,
Ponderosa Drive and Temple

Avenue, Camarillo, Calif.
Meeting Schedule:

8:30 a.m.
8:45-9:30
9:30-10:30
10:30-11:00

11:00-12:00

1:30

Doors open

Internet and e-mail SIG
Business meeting, Q&A
Break — Please contribute
requested amounts for coffee
and doughnuts

Program (Migrating from Windows
XP to Windows 7)

Drawing

After-meeting SIG by Michael
Shalkey



